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Overview and Principles
Ensure the study design adheres to 
fundamental principles of the scientific 
method
 Successful publication determined by how well 

the experiment/study was designed and performed

 Editorial wizardry cannot turn the frog of a flawed, 
unscientific study into the prince of an outstanding 
publication

X

3

Overview and Principles - 2
■ Before starting the study ...

□ Consult an expert in research design
▶ E.g., senior scientist, epidemiologist, etc.
▶ Ensure plan follows scientific method principles

▷ Proper study design, controls, random selection, blinding, 
avoiding bias, etc.

□ Consult a statistician
▶ Ensure suitable sample sizes for comparisons
▶ Too many submissions with only 3-to-5 mice per arm
▶ Unacceptable excuse: “too expensive or difficult to use 

larger numbers”

■ Future manuscript will need to explain and 
justify your research design and statistical models

4

Use Traditional Structure 
Introduction, Methods, Results, and 
Discussion, except for good cause
■ Aids logical flow of ideas
■ Easier to follow for readers (and reviewers)
■ Special types of articles do not use this 

structure
□ Reviews of a subject
□ Editorials
□ Meeting report or conference proceeding
□ Case report

5

■ Authors sometimes misallocate their phrases and 
sentences to the wrong section
□ Explains background/reasons for study?  ➙

Introduction
▶ “… little knowledge of this antibiotic in infants …”

□ Describes what was done?  ➙ Methods
▶ “… determined mean inhibitory concentrations (MICs) …”

□ Reports data generated? ➙ Results
▶ “… 17 (68%) of 25 subjects had MICs greater than …”

□ States implications, compares with others?  ➙
Discussion
▶ “… second study in this age group …”  “… much higher 

MICs than reported by Somsak, et al via intravenous route.”

Use Traditional Structure - 2 

6

The Title
Title should be brief but provide results
■ Title orients reader to nature of work and results
■ Conveys key finding:

□ Poor:  “Study of mobile telephone use and brain 
cancer”

□ Better:  “Status of evidence for association between 
mobile telephone use and brain cancer”

□ Best:  “Mobile telephone use does not appear to 
increase the risk of brain cancer”
▶ (Opposite results for mobile phones and car accidents)

■ Sometimes, no single result justifies mention
□ “Epidemiology of Japanese encephalitis in Laos”
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The Title - 2
Aim for increasing specificity of the title

Source:  Annesley TM. The title says it all. Clin Chem 2010;56(3):357-360 (http://www.clinchem.org/cgi/content/full/56/3/357).  

Contents: (http://www.aacc.org/publications/clin_chem/ccgsw/Pages/default.aspx)

■ Middle example:  The most informative title provides independent variable (statin 
therapy), dependent variable (cholesterol), observed effect (reduction), and 
population studied (CD patients), using just 10 words 
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The Title - 3
Avoid wasteful words, boastful claims, 
abbreviations
■ No need for the obvious in reporting research

□ “a study of”,  “investigation of”,  “development of”,  
“observations on”

■ Be cautious of bragging or self-promotion
□ “new”,  “first”,  “improved”,  “novel”,  “validated”,  

“sensitive”
■ Do not abbreviate in Title unless very common 

and highly standardized
□ OK:  “HIV”, “AIDS”, “DNA” OK
□ But NOT:  “HBV” or “HepB”, “EIA” or “ELISA”, “EPI”, 

“MOPH” or “MPH”, “EMRO”/”WPRO”/“PAHO”
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The Introduction
The why of your study

■ Puts work into context
□ “Sets the scene”, as in a play

▶ Audience/reader knows what to expect

□ Educates reader in regard to the study
▶ Particular field and area of the research
▶ Current understanding and relevant issues 

▷ May cites key publications by others and authors
▷ Avoid extensive literature review!

□ Gaps in knowledge the study aimed to fill

10

The Introduction - 2
The why of your study

■ Explains purpose of study
□ Why was study performed?  
□ To fill what knowledge gap?
□ To answer what key research question?
□ Be precise

■ If possible, justify why it deserves space 
in print

11

The Introduction - 3
Conical format of perspective
■ Horizon changes from broad to narrow

Source:  Annesley TM. "It was a cold and rainy night": set the scene with a good introduction. 
Clin Chem 2010;56(5):708-713 <http://www.clinchem.org/content/56/5/708.full>.
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The Methods
Establishes entire technique of the work

■ Provide sufficient details for others to 
replicate the study

■ Good place to cite miscellaneous details 
□ Regulatory requirements

▶ E.g., identity of ethical oversight committee
□ Publication rules 

▶ E.g., pre-initiation clinical trial registration 
number 

■ In some logical and readable order
□ In parallel to Results, if possible

http://www.clinchem.org/cgi/content/full/56/3/357
http://www.aacc.org/publications/clin_chem/ccgsw/Pages/default.aspx
http://www.clinchem.org/content/56/5/708.full
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The Methods - 2
Details the Who, What, When, Where, 
How, and even some Why of the study
■ Who?

□ Who reviewed/approved the protocol for ethics? 
□ Who supplied the reagents? 
□ Who were the subjects recruited?
□ Who enrolled the study participants? 
□ Who collected the specimens? 
□ Who made the primary diagnosis? 
□ Who maintained the records? 
□ Who reviewed the data? 
□ Who did the statistical analyses? 
□ Who provided the funding?

Credit this and next 5 slides:  Annesley TM. Clin Chem 2010;56(6):897-901
<http://www.clinchem.org/content/56/6/897.full>. 14

The Methods - 3
Details the Who, What, When, Where, 
How, and even some Why of the study

■ What?
□ What type of study was it? 
□ What protocol was followed? 
□ What were inclusion/exclusion criteria for participants? 
□ What treatments were given? 
□ What reagents, lab methods, and instruments were used? 
□ What validation experiments were performed?
□ What endpoints were measured? 
□ What data transformation was performed? 
□ What statistical software package was used? 
□ What was the cutoff for statistical significance? 
□ What control studies were performed? 

Annesley TM. Clin Chem 2010;56(6):897-901 <http://www.clinchem.org/content/56/6/897.full>.
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The Methods - 4
Details the Who, What, When, Where, 
How, and even some Why of the study

■ When?
□ When was the study initiated? 
□ When was the first patient enrolled? 
□ When was the last patient treated/examined? 
□ When were the diagnoses made?
□ When were specimens collected? 
□ When were analyses performed? 
□ When was the study terminated? 

Annesley TM. Clin Chem 2010;56(6):897-901 <http://www.clinchem.org/content/56/6/897.full>. 16

The Methods - 5
Details the Who, What, When, Where, 
How, and even some Why of the study

■ Where?
□ Where were the study participants 

enrolled? 
□ Where was the study performed?
□ Where were the reagents and key 

equipment manufactured or sourced? 
□ Where were the specimens analyzed?
□ Where were the records kept? 

Annesley TM. Clin Chem 2010;56(6):897-901 <http://www.clinchem.org/content/56/6/897.full>.
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The Methods - 6
Details the Who, What, When, Where, 
How, and even some Why of the study
■ How?

□ How was the sample size determined? 
□ How were patients recruited? 
□ How were study participants selected?
□ How were study participants assigned to groups?
□ How were samples collected, processed, stored? 
□ How many replicates were performed? 
□ How was response measured? 
□ How were control and disease groups defined? 
□ How was the data reported? 
□ How were endpoints measured? 

Annesley TM. Clin Chem 2010;56(6):897-901 <http://www.clinchem.org/content/56/6/897.full>. 18

The Methods - 7
Details the Who, What, When, Where, 
How, and even some Why of the study

■ Why? (related to Methods; others in Introduction)
□ Why was a species chosen (mouse, rat)?
□ Why was a selected device/analytical 

method chosen? 
□ Why was a selected experiment 

performed? 
□ Why were experiments done in a certain 

order?

Annesley TM. Clin Chem 2010;56(6):897-901 <http://www.clinchem.org/content/56/6/897.full>.

http://www.clinchem.org/content/56/6/897.full
http://www.clinchem.org/content/56/6/897.full
http://www.clinchem.org/content/56/6/897.full
http://www.clinchem.org/content/56/6/897.full
http://www.clinchem.org/content/56/6/897.full
http://www.clinchem.org/content/56/6/897.full
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The Methods - 8
Examples for biomedical research

■ What?
□ Study design

▶ E.g., case-control, prospective/retrospective cohort, 
cross-sectional, case series, etc.

■ How?
□ Integrity of observation or intervention

▶ E.g., blinding, randomization, controls 
□ Statistical models used to test and claim “significance”

■ When?
□ May be relevant for secular trends

▶ E.g., influenza seasons, disease pandemics, floods
■ Where?

□ Institution(s) (hospital, clinic), city, country
20

The Methods - 9
Describe study steps in a logical order
■ NOT by Who, What, When, Where, How, Why
■ Alternative options for constructing Methods (and Results)

□ By chronology: 
▶ Early steps  ➙ later steps

□ By importance: 
▶ most  ➙ least important

□ By perspective: 
▶ General, broad view  ➙ specific details

□ By topic or experiment, e.g.: 
▶ Analysis of reported surveillance data on a disease
▶ Population survey for the disease
▶ Intervention or experiment on sample of cases
▶ Focus group among patients about intervention
▶ Questionnaire of patient preferences about intervention

■ As parallel as practicable with order used in Results

21

The Methods - 10

■ Use 
parallel 
structure
□ Try to 

follow 
similar 
order in 
both 
Methods
and 
Results
▶ Not 

always 
possible From: Block SL, et al. A randomized, double-blind 

noninferiority study of quadrivalent live attenuated 
influenza vaccine in adults. Vaccine 2011.

22

The Methods - 11
Be a good accountant
■ Be quantitative in describing your subject sample

□ (Some report such subject numbers in early Results)
■ Ensure numbers add up for “dropouts”
■ Provide numerators/denominators so readers can 

do or check percentage calculations 

23

■ Methods = “parents”
□ It takes parents to make children
□ It takes Methods to get Results

■ Results = “children”
□ It takes children to make grandchildren
□ It takes Results to justify Conclusions

■ Conclusions = “grandchildren”

The Methods - 12
ANALOGY - Methods : Results : Conclusion

24

■ Avoid “Childless Methods”
□ No mention in Results of finding or outcome 

of a procedure described in Methods
▶ Remove from Methods, or
▶ Add finding(s) from it in Results

▷ Example: if Methods says “We surveyed parent 
preferences for injection method.”
● Then add in Results: “Parents preferred by two to one the jet 

injector over the needle-and-syringe (data not shown).”

■ Avoid “Orphan Results”
□ No mention in Methods of finding or 

outcome in Results
▶ Again, remove from Results or add to Methods

The Methods - 13
ANALOGY - Methods : Results : Conclusion
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The Results
Tables, figures, and associated text 
reports what you found

■ ORGANIZE AND FINISH TABLES AND FIGURES
FIRST !
□ Before writing a single word of other sections

□ Table and figures are the essence of the work

□ Should provide intuitive understanding
▶ To help “see” and comprehend findings

□ Then write Results text to summarize and 
highlight key points in tables and figures

26

The Results - 2
Distinction between “data” and “results”

■ Some authorities1,2,3 distinguish between ...
□ “Data”, “raw data”

▶ The content of tables and figures
▶ Facts and numbers
▶ Individual data points
▶ Summaries of data (Mean, percent, median, range, etc.)

□ “Results”
▶ Statements in Results text summarizing and explaining “data”

▶ “Results” gives meaning to the “data”

1. Annesley TM. Clin Chem 2010;56(6):897-901 
<http://www.clinchem.org/content/56/6/897.full>.

2. Zeiger M.  Essentials of Writing Biomedical Research Papers.  2nd ed. New York: McGraw 
Hill; 2000 (ISBN 978-0-07-134544-6).

3. Foote M. The proof of the pudding: how to report results and write a good discussion.  
Chest 2009;135(3):866-868 <http://dx.doi.org/10.1378/chest.08-2613>.
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■ In Results text, point readers to location 
for evidence of the finding stated

▶ E.g., “... (Figure 1).”  “... (see Tables 2 and 3) ...”

■ Do not convert all data in tables/figures 
into words

■ Follow similar order as Methods
▶ Most important  ➙ least important, or 
▶ Overview perspective  ➙ details, or
▶ Chronologically, as studied

The Results - 3
Text summarizes and highlights key data 
in tables and figures

28

■ Keep track of subjects like 
a bank does your money
□ Where did every ฿aht and 

satang go?
□ Flow chart always in 

Results 
▶ Some put its text in Methods

■ Flow chart shows how 
subjects recruited and 
“dropped out” from 
analyses
□ Bad arithmetic raises 

suspicion of flawed work

The Results - 4
Accounting

Rerks-Ngarm, et al. N Engl J Med.  2009;361;23:2209-2220

Continued

This no.
minus this

equals this.
Good.

Ambiguous 
indentation:

Is “418” a subset
or in addition to

“8780”?

Dropout
box total

equals
indented

totals.
Good.

Color codes of presentation:
“Praise” in blue (or cyan)
“Criticism” in red (or pink)

29

■ www.consort-
statement.org

■ Flow charts 
required by many 
major journals for 
clinical trials
□ Useful for all 

studies, even if not 
submitted with 
manuscript

The Results - 5
CONSORT rules

Rerks-Ngarm, et al. N Engl J Med.
2009;361;23:2209-2220

Continued

These dropout boxes should be to the side, 
not 
in 

main 
flow

30

■ Most results are in the form of probabilities
□ Cases/events per some population at risk

▶Percentage, proportion, rate, ratio, prevalence, 
incidence

□ Provide numerators and denominators to 
allow readers to see how % determined

The Results - 6
Probabilities

http://www.clinchem.org/content/56/6/897.full
http://dx.doi.org/10.1378/chest.08-2613
http://www.consort-statement.org
http://www.consort-statement.org
http://www.consort-statement.org
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The Discussion
The Discussion section conveys the “so 
what?” and “ who cares?“ of the study
■ Interpret results, explain significance, draw 

conclusions
□ May reiterate principal findings

▶ But phrase differently from Results

■ Relate to original research question(s) and 
formal hypothesis(es) 

■ Compare with work by others in this field
□ Partial reprise of Introduction and its citations
□ Corroborates prior work?  Contradicts it?

32

The Discussion - 2
■ Point out limitations of study to reviewers, 

editors, all the world
□ Often hardest aspect of writing a paper
□ Possible things wrong with conception, 

design, implementation, and analysis
□ Alternative explanations for findings
□ Other research with opposite results

■ Reviewers are more comfortable accepting 
papers so “immunized” from possible error

■ To be discussed in more detail in later 
lecture 

33

The Discussion - 3

■ After pointing out weaknesses and 
limitations … 
□ … you earn the privilege to speculate 

modestly on implications of study
▶ How it may add to knowledge in the field
▶ How it may affect disease prevention, patient 

care, new diagnostics, technology development, 
etc.

▶ Future followup studies needed
□ Modest speculation 

▶ Means “may ...”, maybe ...”, “might ...”
▶ Not “is ...”, “will be ...”

34

■ Avoid “Orphan Conclusions”

□ Claims made in Conclusions that lack 
justifying evidence in Results
▶ a.k.a. “Virgin Births” - no gestation by 

“parents” in Results

□ However, authors are permitted some 
modest speculation on the possible
implications and applications of their 
work

The Discussion - 4
ANALOGY - Methods : Results : Conclusion

35

Exercise 1 – Identify Content Type 
from Published Abstract

■ Allocate abstract sentences into correct 
categories and in logical order:

□ Introduction
□ Methods

□ Results
□ Discussion

36

End of Exercise 1
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WRITING
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International Field Epidemiology Training Programme
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38

Steps to a First Draft 

1. Select a Structure 

2. Create an Outline 

3. Identify Key Terms 

4. Write for Flow

With grateful acknowledgment to 
Robert M. Jacobson, Mayo Clinic

“Writing a First Draft”

Give credit 
when due

39

Steps to a First Draft - 2
Step 1: Select a Structure at Two Levels

■ 1st level determined by nature of writing 
□ Original scientific manuscript 
□ Narrative review 
□ Commentary 
□ Grant application 

■ 2nd level determined by target and 
content 
□ Specific journal 
□ Specific funding organization

Acknowledgment: Robert M. Jacobson, 
Mayo Clinic, “Writing a First Draft” 40

Steps to a First Draft - 3
Step 1: Select a Structure: Original 
Scientific Manuscript

I. Introduction 
● a.k.a. “Background”

II. Methods 
● a.k.a. “Materials and Methods”

III. Results 
IV. Discussion

● a.k.a. “Conclusions”
Acknowledgment: Robert M. Jacobson, 

Mayo Clinic, “Writing a First Draft”

41

Steps to a First Draft - 4
Step 2: Create an outline – a “skeleton” 
to flesh out future details
■ Introduction

□ Explain field, issues, knowledge, and gaps 
□ Limited citations to prior work 
□ Nature and purpose of study  

■ Methods
□ List and detail all steps and processes

▶ Organize in logical order, chronological order, etc. 
▶ Statistics, ethical oversight, when and where

■ Results
□ Parallel order and structure as Methods 
□ Describe the study population at baseline
□ Provide findings generated by the Methods

Acknowledgment: Robert M. 
Jacobson, Mayo Clinic
“Writing a First Draft” 42

Steps to a First Draft - 5
Step 2: Create an outline – a “skeleton” 
to flesh out future details - 2
■ Discussion

□ Significance of major findings of this work 
□ Its place among other work in field 
□ Limitations 
□ Concluding paragraph 

▶ Puts the research in a positive light 
▶ Restate the major findings 
▶ Emphasize how this allows others to proceed 
▶ Describe future work With grateful acknowledgment to 

Robert M. Jacobson, Mayo Clinic
“Writing a First Draft”
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Steps to a First Draft - 6
Step 2: Create an outline – example
I. Introduction
II. Methods

A.  Recruitment of study participants 
B.  Ethical review and regulatory declarations
C.  Questionnaire, survey, specimen collection
D.  Clinical assessment
E.   Laboratory assays 
F.   Data management and  analysis
G.  Statistical tests 

III. Results
A.  Demographic findings 
B.  Subjective reports 
C.  Prevalence of symptom and signs
D.  Laboratory findings 

IV. Discussion

Try to maintain 
parallel structure, 

same order, 
between 

Methods and 
Results

With grateful acknowledgment to 
Robert M. Jacobson, Mayo Clinic

“Writing a First Draft” 44

Exercise 2 – Create an Outline
■ Create 3-level outline of the paper’s Introduction, 

Methods, Results, Discussion
□ First level = I, II, III, IV
□ Second level = A, B, C, D
□ Third level = 1, 2, 3, 4

Suwancharoen D, et al. Serological survey of leptospirosis in livestock in Thailand.  Epidemiology & Infection  
2013;141:2269-2277.

Decimal style 
“3.4.2” OK

45

Exercise 2 – Create an Outline - 2

■ Exercise Discussion
□ Did Introduction educate the reader on current 

knowledge?  What’s unknown? 
▶ Examples?

□ Did Methods “establish” the study? 
▶ Examples?

□ Did Results deliver on the promise of the Methods? 
▶ Examples?

□ Did Discussion point to future steps/direction? 
▶ Examples?

With grateful acknowledgment to 
Robert M. Jacobson, Mayo Clinic

“Writing a First Draft” 46

End of Exercise 2

47

JOINT WORKSHOP ON
SCIENTIFIC
WRITING

IN
FIELD

EPIDEMIOLOGY
Lecture 3:  Formatting and Writing
Tuesday morning  - 2014-02-25

Pakse, Champasak Province, P.D.R. Lao
International Field Epidemiology Training Programme

25 February - 1 March 2014
48

SCIENTIFIC-WRITING WORKSHOP

Lecture 3:

An Editor’s Tips on 
Manuscript Formatting 

and Writing
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Follow Journal Instructions
Consult carefully the journal’s 
guidelines for authors
■ Found at journal’s website

□ E.g., http://www.elsevier.com/locate/inca/30521/authorinstructions

□ Or in printed issue of journal
■ Provides details on structuring your 

manuscript
□ Labeling and numbering sections
□ Preparing tables and figures
□ Citing references

■ Examine recent articles in journal as 
examples

50

Follow Journal Instructions - 2
■ Follow guidance for citing reference 

numbers within text, tables, and figures
 E.g.:   1, 5, 7-9 or   [1,5,9]   or   (1,5,7-9)   

or   a, b, c, d (common in tables)

■ If journal specifies symbols in certain order 
as data points in graphs: 

+   X   □ ■ ● ￮ ▲ ▼
or footnotes in tables: 

*   †   ‡   § ǁ ¶   **   ††   ‡‡   §§ ǁǁ
... use them

51

Follow Journal Instructions - 3
■ Following journal style demonstrates 

authors pay attention to detail
□ Increases credibility for underlying research

▶ Authors can follow protocol, too?

■ Not following journal style raises doubts 
about study implementation 
□ Authors sloppy? Careless? Deviated from 

protocol?
□ Borderline manuscripts may be tipped into 

“reject”
52

Make the Reviewer’s Work Easier 
■ Headers or footers help find places and 

assemble printouts; give total pages

or

53

Make the Reviewer’s Work Easier - 2
How to add total page count to your 
header or footer
■ Microsoft removed the easy way in 

later Word® versions
1. On final line of final page:

□ Commands: Insert > Bookmark > 
(enter a name, e.g. “EndOfFile”) > Add

2. Put cursor at desired location in header, 
footer, or elsewhere. Then:
□ Commands: Insert > Cross-reference > 

Bookmark > Page number > “EndOfFile” > 
Insert

54

Make the Reviewer’s Work Easier - 3 
■ Fonts

□ Use a standard font built into Windows®

▶ Unless journal specifies another
□ May use different fonts to distinguish header or footer from main text

■ Use legible font size
□ Times New Roman: 

▶ 12 point very legible
▶ 11 point minimum

□ Arial
▶ 12 point larger than necessary
▶ 11 point very legible
▶ 10 point minimum 

■ Line spacing
□ Double-spacing, if suggested by journal
□ 1.5-spacing usually acceptable
□ Leaves room for reviewers to make notes in print copy

■ Justification OFF!
□ All lines flush left; right ends of paragraphs “ragged”
□ Justification masks erroneous double spaces between words

http://www.elsevier.com/locate/inca/30521/authorinstructions
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Make the Reviewer’s Work Easier - 4
■ Use continuous line numbering 

▶ Not restarting as line 1 on each new page
▶ In reviews, avoids having to specify page numbers and 

identify paragraph and sentence
▷ For word, phrase, or sentence needing comment

▶ In Word®, tab commands: Page Layout > Line Numbers > Continuous

56

Assemble .doc/.docx file properly
■ Follow standard order for submissions

□ Unless journal requests otherwise
1. Title
2. Authors
3. Affiliations, corresponding author contact 

information
4. Abstract, key words, abbreviations
5. Introduction, Methods, Results, Discussion
6. Acknowledgements, conflict disclosures
7. References
8. Tables with their numbers and titles
9. Figure titles and legends
10. Figures themselves (on separate pages)
 Add figure numbers outside graph field to identify which is 

which (titles/legends not on same page)

□ Do not place tables and figures within text!

57

Assemble .doc/.docx file properly - 2
■ Figure titles/legends NOT on same page as 

figures (titles on preceding pages)

□ Identify each figure
▶ Type in text to identify 

adjacent figure
▶ Well outside figure field

58

■ Use PowerPoint®, Excel®, or other software for making 
graphs, charts, and their labels
□ Copy and paste entire, finished figure into Word document file 

at correct page.  To revise, return to original software.
■ Set Word® commands:

□ File > Options > Display > “Show all formatting marks”
□ After inserting image into Word file, reformat it:

▶ Right click > Wrap Text > Top and Bottom
■ Use caution adding labels with Word®

□ Creates problems when figures are moved. 
□ Create labels

in graph software 

Assemble .doc/.docx file properly - 3
Prepare figures in suitable software

59

Write Well
But don’t worry about the English

■ Difficult language
□ Many ways to express same idea
□ Very idiomatic, thanks to Shakespeare

▶ “a sea change”,  “all of a sudden”,  “mum's the word”,   
“break the ice”,  “in a pickle”,  “much ado about nothing”

□ Spelling does not indicate pronunciation 
▶ cough=“...off”  rough=“...uff”   bough=“...ow”

■ This editor does not expect good English from 
non-native-English speaking authors
□ As long as the meaning is expressed, somehow
□ Find a native-English speaker with science 

background to help edit your English 
60

Write Well - 3
Merge some sentences for variety

■ Poor, boring example (10 sentences):
1. “Mount St. Helens erupted on May 18, 1980. 
2. A cloud of hot rock and gas surged northward from its collapsing slope. 
3. The cloud devastated more than 500 square kilometers of forests and lakes. 
4. The effects of Mount St. Helens were well documented with geophysical 

instruments. 
5. The origin of the eruption is not well understood. 
6. Volcanic explosions are driven by a rapid expansion of steam. 
7. Some scientists believe the steam comes from groundwater heated by the 

magma. 
8. Other scientists believe the steam comes from water originally dissolved in 

the magma. 
9. We need to understand the source of steam in volcanic eruptions.
10. We need to determine how much water the magma contains.”

CREDIT: Michael Alley, Pennsylvania State University
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Write Well - 4
Merge some sentences for variety
■ Pleasing, interesting example (5 sentences):

1. “Mount St. Helens erupted on May 18, 1980, emitting from its 
collapsing slope a cloud of hot rock and gas that in minutes 
devastated more than 500 square kilometers of forests and 
lakes. 

2. Although these effects of the eruption were well documented, 
its origin is not well understood. 

3. Volcanic explosions are driven by a rapid expansion of steam, 
although its source has recently been debated.

4. Is the steam from groundwater heated by magma, or from 
water originally dissolved in the magma itself? 

5. To understand the source of volcanic steam, we have to 
determine how much water the magma contains.”

62

Write Well - 5
Define unfamiliar terms
■ At first mention, italicize and define new 

terms 
■ Define directly or indirectly

□ Directly 
▶ “For purposes of this review, we defined cutaneous 

vaccination as delivery of antigen by all methods 
anywhere into or onto the skin.”  

□ Indirectly
▶ “Fertility in Thailand started to decline in the late 

1960s, reaching as early as the late 1980s the 
replacement rate of 2.1, the average number of  
births to women of child-bearing age needed to 
maintain a steady population (Hirschman, et al. 
1994).“

63

Write Well - 6
Use intuitive and consistent abbreviations

 Always define abbreviations, even common 
ones (exception: common ones in the Title)
 “Human immunodeficiency virus (HIV)”
 “Deoxyribonucleic acid” (DNA)”
 Define abbreviations at first use in (1) abstract, 

(2) text, and (3) in each table/figure footnote
 Then provide abbreviation only for remainder of 

uses
 When definitions extensive, footnotes of first table 

or first figure can provide them
 Footnote in later table(s)/figure(s) refers back to prior one 

for definitions 64

Write Well – 7
Use descriptive labels for study groups

■ Avoid generic labels
□ “Group A”,   “Group B”,   “Group C”
□ Forces forgetful, busy readers back again to 

Methods
■ Use intuitive names that convey group 

identity
□ “0.1mL ID”,     “0.1mL IM”,      “0.5mL IM”
□ “5-yr Boost”,   “10-yr Boost”,   “15-yr Boost”
□ “anti-rAlp3/1:2000”, “anti-rAlp3/1:10000”, “anti-rBCP∆IgA/1:2000”

▶ = “recombinant Group B Streptococcus alpha-like protein 3”

65

Write Well – 8
Avoid or minimize jargon
■ Informal, short-hand, technical terms and 

abbreviations
■ Used in a workplace or narrow field
■ Often unknown by many outside the field 
■ Sometimes have general meaning understood 

differently by general population
■ Examples

□ “Internalizing and externalizing scales”
□ “iPrEx participants”
□ “Neuts”
□ “Open-label”

66

Write Well – 9
Avoid or minimize jargon
■ Example with jargon

□ “For the first year, the links with SDPC and 
the HAC were not connected, and all 
required OCS input data that were artificially 
loaded. Thus CATCH22 and MERWIN were 
not available.”

■ Example without jargon
□ “Because some of links in the computer 

system were not connected the first year, we 
could not run all the software codes.”

CREDIT: Nicole Kelley, 
Massachusetts Institute of Technology
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Write Well - 10
Avoid needlessly complex language

CREDIT: Nicole Kelley, 
Massachusetts Institute of Technology 68

Write Well - 11
Remove redundancy
■ Three sentences

□ “Water quality in the Hawk River declined in 
July.  This decline occurred because of the 
unusually heavy rainfall in July.  All the extra 
rain water overloaded the Tomlin County 
water treatment plant.”

■ One sentence
□ “Water quality in the Hawk River declined in 

July because heavy rainfall overloaded the 
Tomlin County water treatment plant.”

CREDIT: Nicole Kelley, 
Massachusetts Institute of Technology

69

Write Well - 12
Seek both technical review and editing 
assistance before submission.
 Many submissions are surprising
 Lack simple editing for grammar, spelling, style
 Lack technical review by knowledgeable experts
 Share your drafts with colleagues, supervisors, 

others in same institution and elsewhere
 Request critical comments and candid feedback
 For non-English speakers, get help editing for 

good English by a native speaker
 Ideally someone familiar with science
 Commercial, internet services available for a fee 

70

Write Well - 13
Proofread.  Proofread.  Proofread.
 Simple mistakes ...
 Arithmetic 

 E.g., numerators and denominators do not add up
 Formulas

 E.g., “>” instead of “<“ or vice versa
 Spelling
 References 

 Wrong order or missing authors, incorrect title, year, issue, pages
 Mistakes raise doubts in reviewers minds
 Scientific quality of underlying research?
 Sloppy implementation of study?
 Flawed analysis?

 Cannot always judge quality from the paper; reviewers 
use intuition
 Mistakes may undermine credibility, leading to rejection

71

Reviewer Nominations
Suggest potential reviewers who are 
knowledgeable but do not have real or 
perceived conflicts of interest
 Many journals welcome nominations
 Should know the subject matter
 Avoid financial conflicts in nominees
 Own stock or receive money from manufacturers 

of products studied in the reported research
 Avoid emotional conflicts in nominees
 Current or former colleagues at same institution
 Co-authors of past papers
 Good friends or relatives

72

Submission
Submit the paper to one journal, 
selected for its scope, mission, and 
usual content
■ Does this journal often publish such reports?
■ Does this work fall within the stated subjects 

of interest for the journal?
■ How often do you find similar studies as 

yours in the journal?
■ Review article titles and abstracts over prior 

year or two
□ Use MEDLINE journal search and journal website
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Submission - 2
Avoid offences in scientific publishing 
such as plagiarism and falsification
■ Plagiarism = Using another’s words and claiming them as 

ones own
■ Falsification = Providing fake or fictional data 
■ Duplicate submission = Sending the same work to a 

second publisher before first has declined it
■ Redundant Publication = Submitting the same body of 

work to multiple journals with only minor differences
□ Exception: Non-English papers translated into English when 

approved in advance by both journals, with clear description 
of source in second publication

■ Offenders subject to banishment from journal(s) 
□ No excuses such as “not an issue in my country”

■ See Uniform Requirement for Manuscripts (http://www.icmje.org)
74

Submission - 3
Be patient; proper peer review takes 
time.
 Many steps required 
 Receiving and processing
 Assigning editor
 Identifying subject matter experts to review 
 In addition to those nominated by authors

 Vaccine allows 14 days for reviews; some late 
needing reminders

 Good experts are busy
 Must sometimes invite 6 – 12 to obtain 2 -

3 willing to accept task

75

Manuscript Structure and Principles
Further Reading (and credit to:)

■ The Pathway to Publishing: A Guide to 
Quantitative Scientific Writing

▷ http://www.kcri.ac.tz/sites/default/files/uploads/files/Pathway%20to%20Publishing_A%20Guide%20to%20Quantitative%20Scientific%20Writing%20May%202012.pdf

■ Clinical Chemistry Guide to Scientific Writing
▷ http://www.aacc.org/publications/clin_chem/ccgsw/Pages/default.aspx

■ Writing Guidelines for Engineering and Science 
Students
▷ http://www.writing.engr.psu.edu

■ Technical Communications in Mechanical 
Engineering 
▷ http://web.mit.edu/me-ugoffice/communication/

■ Uniform Requirement for Manuscripts
▷ http://www.icmje.org/

76

End of Lecture 3
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■ The structure of tables and figures affects how well readers interpret them
□ Example:  Scientist measures temperature of a liquid every three minutes, and 

records them

□ Which structure is easier to interpret?  Why?
□ Which side of structure 2 exhibits a pattern of regularity?

Tables and Figures
Key concepts *

* Gopen GD, Swan JA.  The science of scientific writing. American Scientist 
Nov-Dec 1990;78:550-558. http://www-stat.wharton.upenn.edu/~buja/sci.html

http://www.icmje.org
http://www.kcri.ac.tz/sites/default/files/uploads/files/Pathway%20to%20Publishing_A%20Guide%20to%20Quantitative%20Scientific%20Writing%20May%202012.pdf
http://www.aacc.org/publications/clin_chem/ccgsw/Pages/default.aspx
http://www.writing.engr.psu.edu
http://web.mit.edu/me-ugoffice/communication/
http://www.icmje.org/
http://www-stat.wharton.upenn.edu/~buja/sci.html
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Tables and Figures
Key concepts - 2

■ What happens when the columns of the table are reversed, as in structure 3?

□ Readers prefer context on the left; with new, important information on the right
□ Information is interpreted more easily if placed where readers expect to find it
□ This applies to both tables and graphs, as well as text (in a later lecture)

80

Tables and Figures
Key concepts - 3

■ Tables 
□ Use when individual quantitative data and 

its summaries must be conveyed
□ Use for large amounts of information 

■ Figures
□ Use to show trends or patterns 
□ Use when comparing differences between 

data sets
□ Use when precision of data not important

81

■ Titles (a.k.a. “legends”) should stand alone
□ Clear and concise
□ Independent of main text of manuscript

▶ Explain content and context enough, without reference to Intro, 
Methods, or Results sections

■ From table or figure, readers should understand 
□ Abbreviations: defined in legend, table, footnote

▶ Later tables or figures can refer back to where defined
□ Study groups: use intuitive, self-identifying names
□ Data types:  identify, e.g., %. CI95%, SEM, SD
□ Source of data: identify if from work of others

■ Places where information can be placed
□ Tables: title/legend text, column/row labels, footnotes
□ Figures: title/legend, in-field codes, axis/series labels, 

footnotes

Tables and Figures
Titles / legends independent of text

82

Tables
Components of a table

Source:  Annesley TM. Bring Your Best to the Table. Clin Chem 2010;56(10):1528-1534
<http://www.clinchem.org/content/56/10/1528.full>.

a.k.a.
Row labels

a.k.a.
Column labels

83

Tables
Components of a table - 2
■ Complete title

□ Describe table content in title/legend
■ Number precedes the title/legend

□ Table 1.  Table 2.  Table 3.  etc.
■ Row labels (“stubs”) are usually the 

independent variables
□ Located in first column on left
□ Use indentation to group subsets within a 

major grouping
■ Columns to the right are dependent 

variables
84

Tables
Components of a table - 3

■ Rows and columns labeled clearly, 
concisely
□ Specific units of measurement shown

▶ e.g., “years”, “mm Hg”, “mg/dL”, “per 100,000”, 
etc.

□ Row and column totals always provided
■ Use “missing value” columns/

□ Total counted should be consistent with flow 
chart and other counts in paper

Credit: CDC Principles of Epidemiology, 2nd ed., 1992 (Course 3030-G). 
http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdf

http://www.clinchem.org/content/56/10/1528.full
http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdf
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Tables
Show Missing
■ Show “missing 

value” numbers
□ So counts consistent 

with other parts of 
paper

□ E.g., Toxin type 
“unknown”

□ Age, race, sex, etc.
■ This table has row 

totals, but no 
regional subtotals

Source:  Infectious Agents Surveillance Report. Botulism in Japan 
as of January 2008. IASR February 2008;29:35-36 
<http://idsc.nih.go.jp/iasr/29/336/tpc336.html)>

Color codes of presentation:
“Praise” in blue (or cyan)
“Criticism” in red (or pink)

86
Vaccine 2013;31(24):2692–2697

Tables 
Missing components

What’s missing?

87
Vaccine 2013;31(24):2692–2697

Tables
Missing components 

Are these N’s the 
numerator or 
denominator?

What are the 
circled 

abbreviations?

What is the study about?
Who are these children?

Cases of 
what?

88

Tables
Provide Rates, Not Just Cases
■ Most scientific findings are in the form 

of probabilities
□ Case counts are often misleading

■ Require both numerator and 
denominator 
□ Expressed as percentage (%) or number 

“per #,### population”
■ Calculate by numerators (cases) above 

denominators (respective population at 
risk)

89

Influenza Like Illness (ILI)               Participating Colleges         Cumulative: 22-28 August 2009 - 30 April 2010
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Tables
Lists tables versus hierarchy tables

■ List tables are descriptive
□ Provide information without analysis

▶ Caveats: when mixing different types of 
information
▷ Column labels may be inapplicable to some cells
▷ Only combine data types if labels can be shared 

▶ Or, add horizontal line and new column labels

□ Use indenting or parentheses in left-hand 
column to indicate subsets

http://idsc.nih.go.jp/iasr/29/336/tpc336.html
http://www.acha.org/ILI_Project/ILI_Cumulative.cfm
http://www.acha.org/ILI_Project/ILI_Cumulative.cfm
http://www.acha.org/ILI_Project/ILI_Cumulative.cfm
http://www.acha.org/ILI_Project/ILI_Cumulative.cfm
http://www.acha.org/ILI_Project/ILI_Cumulative.cfm
http://www.acha.org/ILI_Project/ILI_Cumulative.cfm
http://www.acha.org/ILI_Project/ILI_Cumulative.cfm
http://www.acha.org/ILI_Project/ILI_Cumulative.cfm
http://www.acha.org/ILI_Project/ILI_Cumulative.cfm
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Tables
Caution for list tables - example

Vaccine 2013;31(27):2891-2897

Multiple 
data 

types 
sharing 

Same 
column

No footnotes to 
define abbreviations

“Coverage” 
row does not 
fall  within the 

“Disease 
outcomes” 

group

Indentation of row labels (stubs) indicates subsets within groups

92

Tables
Lists tables versus hierarchy tables

■ Hierarchical tables are analytical, showing effect of variables
□ Hierarchical “spanners” arrange multiple subgroups in the table
□ Example:  “Vision Wire” is experimental new guidewire for heart 

pacemaking.  Two “Galeo” groups are current standard guidewires
▶ This experiment “controls for” anterior or posterior electrode location

Heinroth KM, Unverzagt S, Buerke M, et al. Transcoronary Pacing in a Porcine Model — Impact of Guidewire Insulation. J 
Invasive Cardiol 2011;23(3):108-114.    http://www.invasivecardiology.com/issue/2682?page=1

93

Tables
Caution for hierarchical tables
■ Lay out conducive to interpretation

□ Keep together results requiring direct comparison
□ Minimize required eye movements of the reader
1.

2.

□ In tables with three variables, essential to arrange 
spanners for easiest side-by-side comparisons

94

Tables

Clear grouping 
of row items 
(indenting)

Intuitive 
group 
names

Indicate n for 
each group

Show both 
number and 

percent

Explain key 
terms DID NOT 

keep 
together most 

important 
comparisons

Define abbreviations

Woodcock NP, et al. Nutrition 2001.Give credit when due

95

Exercise 3 – Create Two-variable Table  
from Line Listing

Participants work individually.

Create table on a separate sheet according to the 
instructions and line listing provided.  

Exercise adapted from:
CDC. Principles of Epidemiology: An Introduction to Applied Epidemiology 

and Biostatistics, 2nd ed. Self-study Course 3030-G, 1992 
(http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdf or  
http://www.facmed.unam.mx/deptos/salud/bibliotecav/epi_course.pdf)

96

End of Exercise 3

http://www.invasivecardiology.com/issue/2682?page=1
http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdfor
http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdfor
http://www.facmed.unam.mx/deptos/salud/bibliotecav/epi_course.pdf
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■ Appropriateness:
□ Show data visually that is not easily 

understandable in text or table
▶ E.g., patterns, trends, aberrations, similarities, and 

differences in data. 
▶ Better remembered by readers and audience

■ Efficiency:
□ Convey maximum data using minimal ink

■ Independence:
□ Figure and its legend should stand by itself 

without reference to text
□ Use titles, legends, and footnotes that explain the 

content

Graphs - Principles

99

■ Graphs have two coordinates 
□ Horizontal x-axis and vertical y-axis -- both continuous variables 

▶ Y axis - usually the dependent (or y) variable
▷ Often a frequency measure, such as number of cases or rate of disease 

▶ X axis - usually the independent (or x) variable, which is what is 
manipulated or observed by the investigator
▷ Often represents time

■ Charts have 1 continuous and 1 nominal variable
□ E.g., number of cases (a continuous variable) by sex (a nominal 

variable)

■ Types of graphs and charts
□ Simple bar and pie charts display distributions of single variable
□ Grouped and stacked bar charts display ≥2 variables 
□ Spot maps pinpoint locations  cases or events
□ Area maps use shading or coloring to show different disease level

Graphs - Fundamentals

Credit: CDC Principles of Epidemiology, 2nd ed., 1992 (Course 3030-G). 
http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdf 100

■ Complete title
□ Describe graph content in title/legend
□ Number precedes the title/legend

▶ Figure 1.  Figure 2.  Figure 3.  etc.
■ Axes

□ Labeled clearly and concisely to show name of the 
variable and its units
▶ e.g., years, mm  Hg, mg/dL, rate per 100,000, etc.

□ Scale divisions clearly indicated with tick marks
▶ Y-axis starts at zero
▶ Range of values of Y-axis scale is set by the largest value 

to be graphed, plus rounding up 
▷ Example:  largest y-value = 763,094, set highest visible y-axis 

value at 800,000 or even 1,000,000
□ Scale breaks clearly identified

Graphs - Key Ingredients and Features

101

■ Coordinate (grid) lines
□ Optional; only as many as needed to guide eye to help 

readers estimate quantitative value of data points (bars or 
lines)

□ Grid lines drawn lighter than axis lines
■ Data plots

□ Drawn clearly
□ Distinguish clearly between multiple plots
□ Each series or component labeled 

▶ On the graph, in a legend, or in a key
■ Footnotes provide details

□ Abbreviations, codes, and symbols explained
□ Later figures can refer back to footnotes in earlier figure
□ All exclusions noted
□ If data not original, source is provided

Graphs - Key Ingredients and Features

102

■ Visual Display
□ No unnecessary information included
□ Figure positioned on page for optimal readability
□ Minimize wasted blank (white) space
□ Provide both high and low sampling error bars, if 

relevant
■ Legibility

□ Font sizes and series color keys sufficiently large for 
reading without magnifying glass

□ Use empty space to enlarge stingy font sizes and series 
color codes

■ Simplicity 
□ Avoid excessive colors or 3-dimensions unless they add 

value

Graphs - Key Ingredients and Features

http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdf
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■ Caveat: two common uses of term “legend”
□ The explanation text that accompanies the figure
□ The key (code) to explain colors or icons in figure

Rerks-Ngarm, et al. NEJM 2009

Graphs - Legends

104

■ Title legends should:
□ Indicate clearly number of subjects (mice or 

men) in each study arm (investigational or 
control)

□ Define nature of high-low sampling error 
bars

▷ 95% C.L., Standard Error (of mean), Standard 
Deviation

▷ In general, avoid SD as it does not reflect sample size

Graphs - Legends

105

Graphs 

Label each 
axis clearly

This is the “code”
Too small ? Use empty space within figure

Identify and show 
both high-low 

sampling error bars

Bar shadings that work in black-
white.

No solid blacks to hide lower 
error bar

Complete 
explanation, 

but 
not for 

abbreviations

106

Graphs - Dots
■ Dot plots preferable to 

bar graphs
■ Horizontal bars can show 

□ Central tendency (e.g., 
mean)

□ High-low sampling error 
(not shown here)

■ Dots show sample size 
and skewness
□ Hidden by bar graphs 

showing only mean
■ “Jitter" dots to sides 

symmetrically to see all 
data points

Frech SA, et al. Use of a patch containing heat-labile toxin from Escherichia coli against travellers' diarrhoea: a 
phase II, randomised, double-blind, placebo-controlled field trial.  Lancet 2008;371(9629):2019-2025.

107

Graphs 
Do not rely on color alone
 Data points, lines, and shapes may not be 

distinguishable in grayscale printouts
 Consider readers without color printers; color blind
 Ensure groups and series are also distinguishable 

when output from black-white printers

108

Graphs
Do not rely 
on color only
■ Example

□ Series line 
distinctions lost in 
grayscale printout

□ Data point 
symbols too small 
to help

■ Earlier lesson
□ Be kind to 

reviewers and 
readers

Gildea S, et al. Vaccine 2011;29:9214–9223. 
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Graphs
Do not rely on color alone

Use more than color for data
 Data points:  use various shapes and symbols

 Data lines: use dotting patterns

 Data shapes: use crosshatchings or shadings

110

Graphs
Do not rely on 
color only

■ Good example
□ Colors also 

have different 
grey-scales
▶ (next image)

□ Different 
pattern fills and 
symbols  
distinguish 
regions
▶ +  ∕ ∕  ─ Ƴ | 

■ ▢ x △

Suwancharoen, et al. Epidemiol & 
Infect 2013;141:2269-77. 

111

Graphs
Do not rely on 
color only
■ Good example 

(cont.)
□ Distinguisable

grey-scales
□ Pattern fills and 

symbols still  
distinguish regions
▶ +  ∕ ∕  ─ Ƴ | ■ ▢

x △

Suwancharoen, et al. Epidemiol & 
Infect 2013;141:2269-77. 112

Graphs - Example to critique

Kim SH, et al. Enhancement of the Immune Responses of Mice to Bacillus anthracis Protective Antigen 
by CIA07 Combined with Alum.  Arch Pharm Res Vol 31, No 11, 1385-1392, 2008

 Pros?

 Cons?

Fig. 4. Toxin neutralization activity of the sera of A/J mice immunized with PA combined 
with adjuvants. Sera from the A/J mice immunized as described in Fig. 1 were 
evaluated for TNA titers. (A), TNA activity at 4 week post-priming;   (B), TNA activity at 
4 week post-boosting.
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Graphs - Example to critique

Kim SH, et al. Enhancement of the Immune Responses of Mice to Bacillus anthracis Protective Antigen 
by CIA07 Combined with Alum.  Arch Pharm Res Vol 31, No 11, 1385-1392, 2008

Fig. 4. Toxin neutralization activity of the sera of A/J mice immunized with PA combined with 
adjuvants. Sera from the A/J mice immunized as described in Fig. 1 were evaluated for TNA 
titers. (A), TNA activity at 4 week post-priming;   (B), TNA activity at 4 week post-boosting. Pros?

 Cons?
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Graphs - Improved previous example
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Use empty plot field space
for color key, to keep 
graph as wide as possible.
Add outline and fill.

(Title not shown for space reasons)
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Graphs - Improved previous example
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Graphs - Flow Chart Examples

■ Flow charts required only for 
intervention and cohort trials
□ But useful, even if never published
□ Helps keep track of your subjects

■ Top to bottom vertical flow
□ Chronological sequence

■ Right or left flow
□ Exclusions and losses to followup
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Graphs – Flow Chart Examples

PRAISE: Downward arrows 
show main flow of 
Continuing subjects. 
Sideward arrows for 
Exclusions, dropping out 
of study. 

From: Frech SA et al. Use of a patch containing heat-
labile toxin from Escherichia coli against travelers' 
diarrhoea: a phase II, randomised, double-blind, placebo-
controlled field trial. Lancet  2008:371:2019-2025.

PRAISE: Outside of box, give totals  
at each stage (row) of study

PRAISE: Indented numbers are 
subtotals of box total
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Graphs – Flow Chart Examples

PRAISE: Use sideways arrows for Exclusions, 
downward arrows for Continuing subjects.

Rerks-Ngarm, et al. N Engl J Med.  2009;361;23:2209-2220

(continued to right)

(continued from left)

CRITICIZE: 
Exclusion 
boxes 
should be 
to sides 
of main 
flow
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Graphs –
Flow Chart 
Examples

From: Li L, Liang L-J, Lee S-J, Iamsirithaworn S, 
Wan D, Rotheram-Borus MJ.  Efficacy of an 
intervention for families living with HIV in Thailand: 
A randomized controlled trial.  AIDS Behav 2011. 

CRITIQUE: Place all 
subjects in boxes, 
not loose in the table

CRITIQUE: Place all 
subjects in boxes, 
not loose in the table

CRITIQUE: Use arrows to 
connect boxes to make 
flow clear, not just lines
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CRITIQUE: Use shading or 
other means to 
distinguish boxes not 
mutually exclusive 
(some subjects in 
more than one box).

CRITIQUE: Use shading or 
other means to 
distinguish boxes not 
mutually exclusive 
(some subjects in 
more than one box).

Graphs – Flow Chart Examples

From: Belshe RB, et al. Efficacy Results of a Trial of a Herpes Simplex Vaccine.  N Engl J Med 2012;366:34-43.

CRITIQUE: Use sideways arrows for 
Exclusions, downward arrows for 
Continuing subjects.

CRITIQUE: Use sideways arrows for 
Exclusions, downward arrows for 
Continuing subjects.

CRITIQUE: Use sideways arrows for 
Exclusions, downward arrows for 
Continuing subjects.

CRITIQUE: Use sideways arrows for 
Exclusions, downward arrows for 
Continuing subjects.



Page 21

Joint Workshop on Scientific Writing In Field Epidemiology  - Lectures 1-5 (2014-02-25)
Bruce G. Weniger, MD, MPH, International Professor, Chiang Mai University

International Field Epidemiology Training Programme, Champasak Grand Hotel, Pakse, P.D.R. Lao, 25 February - 1 March 2014

121

Graphs – Flow Chart Examples

From:
Peterson L, et al.
Tenofovir disoproxil
fumarate for prevention 
of HIV infection in 
women: A phase 2, 
double-blind, 
randomized, placebo-
controlled trial.  
PLoS Clin Trials 
2007;2(5):e27 

CRITIQUE: Should use 
sideways arrows for 
losses to followup and 
discontinuations, not 
downward arrows.

CRITIQUE: Should use parallel boxes 
(with shading or dotted outlines) 
for analytical subcategories in same 
cohort
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Graphs – Flow Chart Examples

Color and 
style coding 
distinguish 
different 
cohorts

Color and 
style coding 
distinguish 
different 
analytical
cohorts

(continued next
slide)
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Graphs – Flow Chart Examples
(continued from prior slide)
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Exercise 4 – Construct Line Graphs
From: CDC. Principles of Epidemiology: An Introduction to Applied Epidemiology and Biostatistics, 2nd ed. Self-study Course 

3030-G, 1992 (http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdf or  
http://www.facmed.unam.mx/deptos/salud/bibliotecav/epi_course.pdf). 

■ GRAPH A (workshop groups A and C):
□ Construct an arithmetic-scale line graph of the case-report data in Table 4.11 below, 

showing measles rates in the U.S. from 1955-1990. 

■ GRAPH B (workshop groups B and D):
□ Construct a second arithmetic-scale line graph of the same measles data only for the 

period from 1980 through 1990.

Be sure to include all the essentials for graphs:
•  Complete but succinct title describing subject, person, 

place, and time, preceded by “Figure” and a number
•  Each axis labeled clearly and concisely
•  Specific units of measurement included as part of axis 

labels
•  Appropriate scales for each axis for the data represented
•  Y-axis starts at zero; clearly identifiable scale break, if 

any
•  Axis lines drawn heavier than other coordinate lines, 

such as grid lines in the plot field
•  Only as many coordinate lines as needed to guide the 

eye
•  Clearly drawn plot(s)
•  If data points are shown for multiple series lines, symbols 

are large enough to distinguish among them   
•  If multiple series are shown, they are identified clearly by label, legend, and/or key 
•  Color, shading, and cross-hatching allow each series to be identified on black-and-white printouts 
•  Footnotes explain all codes, abbreviations, symbols, exclusions, and sources of data 
•  Efficient use of space with large, legible fonts for all text 
•  Minimal wasted empty space in plot field
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End of Exercise 4

http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdfor
http://www.cdc.gov/osels/scientific_edu/SS1978/SS1978.pdfor
http://www.facmed.unam.mx/deptos/salud/bibliotecav/epi_course.pdf

